Viewing and Managing IPv4 Addresses

You can view and manage IPv4 address data in the IP Map and IP List panels. Grid Manager displays the IP Map and List panels for a specific network after you navigate through the network hierarchy, or when the selected network does not have subnets under it.

IP Map

The IPv4 Map panel provides a graphical representation of all IPv4 addresses in a given subnet. IP Map displays cells that represent IPv4 addresses. Each cell in the map represents an IPv4 address, and its color indicates its status as described in the legend section. You can run a network discovery on the selected network, and the status of each IP address is updated accordingly. For information, see Chapter 14, IP Discovery and vDiscovery.

Each IP Map panel can accommodate up to 256 cells with each cell representing an IP address. If a given network has more than 256 addresses, additional IP addresses are displayed by paging to the next page. You can use the page navigation buttons to page through the IP addresses. To go to a specific IP address, you can enter the IP address in the Go to field or click a specific cell in IP Map. IP Map has a basic and an advanced view. You can toggle between these views by clicking Toggle Basic View or Toggle Advanced View. As illustrated in Figure 13.7, the status of an IP address is represented with a different color in the IP Map panel.

In the basic view, the IP Map panel displays the following IP address status:

- **Unused**: An IP address that has not been detected and is not associated with any network device or active host on the network.
- **Conflict**: An IP address that has either a MAC address conflict or a DHCP lease conflict detected through a network discovery.
- **Used**: An IP address that is associated with an active host on the network. It can be a resource record, fixed address, reservation, DHCP lease, or host record.
- **Pending**: An IP address that is associated with a scheduled task or approval workflow, and the associated operation has not been executed yet. This IP address is not considered when using the next available IP address function.
- **Selected IP Address**: The IP address that you selected.
- **DHCP Range**: The IP addresses within a DHCP range in the network. The appliance highlights the cells using a blue background.
- **Reserved Range**: A range of IP addresses that are reserved for statically configured hosts. They are not served as dynamic addresses. You can allocate the next available IP from the reserved range when you create a static host.

In the advanced view, the IP Map panel displays additional status as follows:

- **Unmanaged**: An IP address that has a discovered host, is not previously known to the appliance, and does not have an A record, PTR record, fixed address, host address, lease, or is not within a DHCP range. You can change an unmanaged address to a host, DHCP fixed address, A record, or PTR record. You can also clear an unmanaged address. All existing administrator permissions apply to the unmanaged addresses.
- **Fixed Address/Reservation**: A host that is either a fixed address or reservation.
- **DNS Object**: An object that is configured for DNS usage.
- **Host Not in DNS/DHCP**: An IP address that is associated with a host record, but is not configured for DHCP or DNS services.
- **Active Lease**: An IP Address that has an active DHCP lease.
- **DHCP Exclusion Range**: A range of IP addresses within a DHCP range. The appliance cannot assign addresses in the exclusion range to a client. You can use these addresses as static IP addresses. This prevents address conflicts between statically configured devices...
and dynamically configured devices.

**Note:** For a Microsoft split-scope range, the appliance highlights the cells using a combination of orange and pink background colors when the network is managed by two Microsoft servers. For a DHCP exclusion range, the appliance highlights the cells using an orange background.

Under the IP map, Grid Manager displays the following information for the IP address that you have selected in the map:

- **Type:** The object type that is associated with the IP address. For example, this can be Lease, IPv4 DHCP Range or Fixed Address.
- **Comment:** Additional information about the IP address.
- **Lease State:** The lease state of the IP address. This can be one of the following: Free, Backup, Active, Expired, Released, Abandoned, Reset, BootP, Static, Offered, or Declined.
- **Name:** The name of the object type associated with the IP address. This field displays the name of the object type in the native character set if a host record contains IDNs. If a host record contains IDNs in punycode, this field displays the name in the punycode representation. For example, if the IP address belongs to a host record, this field displays the hostname. For IDNs, this field displays the name in the native character set. If punycode is used, then the appliance displays name in punycode.
- **MAC Address:** The discovered MAC address of the host. This is the unique identifier of a network device. The discovery acquires the MAC address for hosts that are located on the same network as the Grid member that is running the discovery. This can also be the MAC address of a virtual entity on a specified vSphere server. The appliance displays an X mark beside the MAC address if it is invalid. For more information about invalid MAC addresses, see *Synchronizing IP Addresses with Invalid MAC Addresses*.
- **DHCP Fingerprint:** The name of the DHCP fingerprint or vendor ID of the network device that was identified through DHCP fingerprint detection. This field displays No Match for devices that do not have any DHCP fingerprint information. For information about DHCP fingerprints, see *DHCP Fingerprint Detection*.

You can do the following in the IP Map panel:

- Click **Go to DHCP View** to view DHCP properties of a selected network.
- Select an address range by clicking once on a start address and then use SHIFT+click on the end address. Click **Add -> Range** from the Toolbar to add the selected range as an IPv4 or IPv6 DHCP range or reserved range.
- Click the Resolve Conflict icon to resolve IP address conflicts. For information, see *Resolving Conflicting Addresses*.
- Click the Ping icon to ping a selected IP address. For information, see *Pinging IP Addresses*.
- Click the Reclaim icon to reclaim an IP address. For information, see *Reclaiming Objects Associated with IPv4 and IPv6 Addresses*.
- Click the Clear icon to clear an active lease. For information, see *Clearing Active DHCP Leases*. You can also select an IP address from the IP Map panel and view the following information:
  - General information, as described in *IP Address Header Panel*.
  - Data retrieved through a network or integrated from a PortIO appliance and Trinzic Network Automation. For information, see *Viewing Discovered Data*.
  - The records associated with the IP address, as described in *Related Objects*.
  - The audit history, as described in *Audit History*.
  - Detailed lease information, as described in *Viewing Detailed Lease Information*.
  - Click **DHCP View** to view DHCP properties of the selected network. For information, see *Modifying IPv4 Networks*.
  - View active network users, as described in *Viewing Active Network Users*.

### IP Address List

The IP address **List** panel displays all IPv4 addresses of a selected subnet in table format. The list provides information about the IP addresses in a hierarchy view. You can use this list to view detailed information about each IP address and its related objects in a selected network. This list provides information such as address status, object type, and usage.

You can configure filter criteria to display only IP addresses that you want to see in the table. For example, you can enter "MAC Address begins with 00" as the filter criteria to view only IP addresses that have associated MAC addresses that begin with 00. You can also enter a specific IP address in the **Go to** field to view information about the address.

Grid Manager can display the following information for the IP addresses. You can edit the columns to display information that is not shown by default.

- **IP Address:** The IP address of the corresponding record. The appliance highlights disabled DHCP objects in gray. A DHCP object can be an DHCP address range, fixed address, reservation, host configured for DHCP, or roaming host with an allocated IP address.
- **Name:** The name of the object type associated with the IP address. For example, if the IP address belongs to a host record, this field displays the hostname.
- **MAC Address:** The discovered MAC address of the host. This is the unique identifier of a network device. The discovery acquires the MAC address for hosts that are located on the same network as the Grid member that is running the discovery. This can also be the MAC address of a virtual entity on a specified vSphere server.
- **Bridge Domain:** The name of the discovered bridge domain. This column will display values only for IP addresses that are discovered from Cisco APIC through Network Insight or NetMRI. If discovered by NetMRI, the value will be populated through IPAM Sync. Otherwise, this column will be blank. For information about how to configure Cisco APIC, see *Configuring Cisco Application Policy Infrastructure Controller (APIC)*.
- **Tenant:** The name of the discovered tenant. This column will display values only for IP addresses that are discovered from Cisco APIC through Network Insight or NetMRI. If discovered by NetMRI, the value will be populated through IPAM Sync. Otherwise, this column will be blank. For information about how to configure Cisco APIC, see *Configuring Cisco Application Policy Infrastructure Controller (APIC)*.
- **EPG:** The name of the end point group. This column will display values only for IP addresses that are discovered from Cisco APIC.
## DHCP List Neighbor Information

Other values will be available for display in the **List** page. Most of the hidden columns consist of information discovered by Grid Manager, to identify devices connected to the network interfaces neighboring the listed IP addresses in the table. These data columns are hidden and must be selected for display by the operator by selecting the **Visible** check box for each field when editing the columns for the table. (Most of this information will not appear unless a device is recognized in IPAM or is in managed state under IPAM.) Additional values include:

- **Discovered Name**: The discovered name of the device bound to the IP address. The IP address may be just one of several or many IP addresses bound to the device on a specific interface.
- **Discovered MAC Address**: The discovered MAC of the interface bound to the IP address.
- **Discoverer**: Name of the Infoblox appliance that discovered the IP address and its associated information.
- **Attached Device Description**: Listing of the device neighboring to the IP address.
- **Attached Device Address**: The IP address of the neighboring device to the current IP.
- **Attached Device Name**: The host name of the device discovered as neighboring to the current IP.
- **Attached Device Vendor**: The device vendor for the neighbor to the current IP address.
- **Attached Device Model**: The device vendor’s model number for the neighbor to the current IP address.
- **Attached Device Port Description**: An admin-provided description for the neighboring IP address, if any is discovered.
- **Attached Device Port Name**: The standard port name for the interface facing the current IP address.
- **Attached Device Port**: The neighboring device's connected port number.
- **Attached Device Type**: Indicates the device type for the neighboring device: **Router, Switch-Router, Switch**, and other types.
- **Port Duplex**: Discovered Duplex setting for the neighboring port, when applicable.
- **Port Link**: Indicates the state of the link: **Connected** or **Disconnected**.
- **Port Speed**: Indicates the speed of the network connection.

### Notes:

- For an IP address that falls within a DHCP range, Grid Manager displays extensible attribute values for the DHCP range and fixed address or host record. When you view the same IP address in the **DHCP** tab however, Grid Manager displays only the extensible attribute values associated with the fixed address or host record, but not the DHCP range. For example, when you define extensible attribute **State** with the value **California** for DHCP range **1.0.0.1** – **1.0.0.5**, and then define extensible attribute **State** with the value **Alaska** for fixed address **1.0.0.3**, Grid Manager displays both **California** and **Alaska** in the **State** field for IP address **1.0.0.3** in the IP Address List view. However, when you view **1.0.0.3** from the **DHCP** tab, the **State** field displays **Alaska** only.

---

### Important Notes:

- **DHCP Client Identifier**: For an IPv4 address, the DHCP Unique Identifier of the host.
- **Port Reservation**: Lists any Port Reservation from Network Insight that is associated with the IP address. The information takes the form of `device_name:interface_name`.
- **VIP**: Indicates when the IP address is operating as a Virtual IP and operates in router redundancy.
- **Status**: The current status of the corresponding record. This can be **Used** or **Unused**.
- **Type**: The object type that is associated with the IP address. For example, this can be **Broadcast, Lease, IPv4 DHCP Range** or **Fixed Address**.
- **Discover Now**: Indicates when the network is undergoing a current discovery process. A “Pending” icon appears in this column when you start the discovery and displays **Completed** after the completion of the discovery process.
- **Discovered IPv4 Address**: The operating system of the discovered host. The OS value can be one of the following:
  - **Microsoft** for all discovered hosts that have a non-null value in the MAC addresses using the NetBIOS discovery method.
  - **A value that a TCP discovery returns**.
  - **The OS of a virtual entity on a vSphere server**.
  
  Note that this field sometimes displays the percentage of certainty about the discovered OS.

- **Device Type(s)**: The type of device associated with the IP address, if any: **Router, Switch-Router, and other types**.
- **Open Port(s)**: Lists any TCP/UDP ports that are open on the current IP address.
- **Open Port Description**: An admin-provided description for the neighboring IP address, if any is discovered.
- **Open Port Use**: Indicates whether the IP address is configured for DHCP or DNS.
- **Open Port Name**: The name of the discovered IP address, if any was previously assigned by an administrator.
- **Discoverer**: The identity of the appliance that discovered the IP address. It is usually the ID or task name that collected the data. It is defined on the corresponding Tranzic Network Automation appliance when you import the discovered data to the NIOS appliance. The task name should be defined in the vDiscovery task manager for vDiscovery.
- **Comment**: Additional information about the IP address.
- **First Discovered**: The timestamp when the IP address was initially discovered. This data is read-only.
- **Last Discovered**: The timestamp when the IP address was last discovered. This data is read-only.
- **OS**: The operating system of the discovered host. The OS value can be one of the following:
  - **Microsoft** for all discovered hosts that have a non-null value in the MAC addresses using the NetBIOS discovery method.
  - **A value that a TCP discovery returns**.
  - **The OS of a virtual entity on a vSphere server**.
  
  Note that this field sometimes displays the percentage of certainty about the discovered OS.

- **NetBIOS Name**: The returned NetBIOS name from the last discovery.
- **Device Type(s)**: The type of device associated with the IP address, if any: **Router, Switch-Router, and other types**.
- **Open Port(s)**: Lists any TCP/UDP ports that are open on the current IP address.
- **Open Port Description**: An admin-provided description for the neighboring IP address, if any is discovered.
- **Open Port Use**: Indicates whether the IP address is configured for DHCP or DNS.
- **Open Port Name**: The name of the discovered IP address, if any was previously assigned by an administrator.
- **Discoverer**: The identity of the appliance that discovered the IP address. It is usually the ID or task name that collected the data. It is defined on the corresponding Tranzic Network Automation appliance when you import the discovered data to the NIOS appliance. The task name should be defined in the vDiscovery task manager for vDiscovery.
- **Comment**: Additional information about the IP address.
- **First Discovered**: The timestamp when the IP address was initially discovered. This data is read-only.
- **Last Discovered**: The timestamp when the IP address was last discovered. This data is read-only.
- **OS**: The operating system of the discovered host. The OS value can be one of the following:
  - **Microsoft** for all discovered hosts that have a non-null value in the MAC addresses using the NetBIOS discovery method.
  - **A value that a TCP discovery returns**.
  - **The OS of a virtual entity on a vSphere server**.
  
  Note that this field sometimes displays the percentage of certainty about the discovered OS.

- **NetBIOS Name**: The returned NetBIOS name from the last discovery.
- **Device Type(s)**: The type of device associated with the IP address, if any: **Router, Switch-Router, and other types**.
- **Open Port(s)**: Lists any TCP/UDP ports that are open on the current IP address.
- **Open Port Description**: An admin-provided description for the neighboring IP address, if any is discovered.
- **Open Port Use**: Indicates whether the IP address is configured for DHCP or DNS.
- **Open Port Name**: The name of the discovered IP address, if any was previously assigned by an administrator.
- **Discoverer**: The identity of the appliance that discovered the IP address. It is usually the ID or task name that collected the data. It is defined on the corresponding Tranzic Network Automation appliance when you import the discovered data to the NIOS appliance. The task name should be defined in the vDiscovery task manager for vDiscovery.
- **Comment**: Additional information about the IP address.
- **First Discovered**: The timestamp when the IP address was initially discovered. This data is read-only.
- **Last Discovered**: The timestamp when the IP address was last discovered. This data is read-only.
- **OS**: The operating system of the discovered host. The OS value can be one of the following:
  - **Microsoft** for all discovered hosts that have a non-null value in the MAC addresses using the NetBIOS discovery method.
  - **A value that a TCP discovery returns**.
  - **The OS of a virtual entity on a vSphere server**.
  
  Note that this field sometimes displays the percentage of certainty about the discovered OS.
Using the List Panel Action Menu

The IP address List panel provides an Action icon.

column with a series of menu options for features related to IP address management and IP data management under IPAM. Menu choices change based upon the context and the current state of IP addresses in the table; features available in the List panel action menu include the following:

- **(Applies only with Network Insight) View Router Redundancy** information for discovered IP addresses in an IPv4 network. For active VIPs, you will see several sets of related information:

  - **Active**: lists the active interface in the redundancy pair;
  - **VIP**: The Virtual IP for the router redundancy pair;
  - **Standby**: The standby IP interface for the router redundancy.

Discovery of all three IP components of the Router Redundancy instance also provides related information for all three IP entities:

- **Show IPAM Address**: opens the IPAM page to the listed IP address;
- **VIP**: Opens the virtual interface in the host device's Interfaces page;
- **Associated router**: The third item lists the hostname router for each of the three IP address entities comprising the redundancy instance. The currently active router will be identified with the **Active** and **VIP** objects; the second **Standby** router is identified with the **Standby** IP address.

  - **Show Interfaces View**: Opens the IP address' related Interface page to highlight the interface's listed information in the table.
  - **Assets View → Show Assets**: Opens the IP address's list of network assets that are connected to the IP address or reachable through the IP address in some way, such as through a routable path. Provides a quick look at basic connectivity provided by the selected IP address; for more information about Assets views, see **Viewing Assets Associated with Discovered Devices**.
  - **Clear**: Allows you to remove data associated with the currently selected IP address, form three categories:
    - **Clear Lease**: If the IP interface gets its configuration from a DHCP lease, choosing this option will clear the IP's DHCP configuration. Applies only to IP addresses that are fully managed through IPAM;
    - **Clear Unmanaged Data**: Clears the discovered data for an unmanaged IP address;
    - **Clear Discovered Data**: Clears discovered data from the IPAM object, and re-launches discovery afterwards if necessary.
  - **Convert**: Conversion feature to convert the currently unmanaged IP address to an object fully managed by IPAM: Network, To Host, To A Record, To PTR Record, or To Fixed Address. (For related information, see Managing DIScovered Data, About Host Records, Managing A Records and Managing PTR Records.)
  - **Discover Now**: Requests Grid Manager to execute discovery on the selected IP address.
  - **Exclusion**: Exclude or disable exclusion of the current IP address from discovery. For related information, see Excluding IP Addresses from Discovery.
  - **Show Active Users**: Displays all the users who are currently active on the selected network. For information, see Viewing Active Network Users.

Additional IP List Information

You can display all available extensible attributes. You can also sort the list of IP addresses in ascending or descending order by IP Address only. If you enabled the IP Discovery feature, you can configure the IP List panel to display discovered data and fields imported from NetMRI appliances. For information about integrating discovered data from NetMRI, see Integrating DIScovered Data From NetMRI.

You can select an IP address from the List panel and view the following information about it:

- General information, as described in IP Address Header Panel.
- Data retrieved through a network discovery or integrated from a PortIQ appliance, as described in Viewing DIScovered Data.
- The records associated with the IP address, as described in Related Objects.
- Audit history, as described in Audit History.
- Detailed lease information, as described in Viewing Detailed Lease Information.

You can also do the following from the IP List panel:

- Click **Go to DHCP View** to view DHCP properties of a selected network. For information, see Modifying IPv4 Networks.
- Click the Ping icon to ping a selected IP address. For information, see Pinging IP Addresses.

Filtering the IP Address List
You can filter the IP address list, so it displays only the IP addresses you need. You can filter the list based on any combination of extensible attributes and the parameters displayed in the IP address list, such as usage and type. When you expand the list of available fields you can add to the filter, note that the extensible attributes are those with the gray background.

**IP Address Header Panel**

When you select an IP address from the IP Map or List panel, Grid Manager displays information about the highest priority object associated with the IP address. Depending on the object type, Grid Manager displays all or some of the following information. For example, if the highest priority object is a fixed address, Grid Manager displays only the object type, MAC address, lease state, and comment of the object.

- **Type**: The object or record type, such as A record, PTR record, or host record.
- **Name**: The name of the object. For example, if the IP address belongs to a host record, this field displays the hostname. The appliance highlights disabled DHCP objects in gray. A DHCP object can be a DHCP address range, fixed address, reservation, host configured for DHCP, or roaming host with an allocated IP address.
- **MAC**: The MAC address of the network device associated with the IP address.
- **Lease State**: The current status of the DHCP lease.
- **Comment**: Comments about the IP address.

**Discovered Data**

The Discovered Data tab displays discovered data through a network discovery or integrated from PortIQ and NetMRI appliances. For information about viewing discovered data, see Viewing Discovered Data.

**Related Objects**

The Related Objects tab displays the following information about the records associated with the IP address:

- **Name**: The name of the object. For example, if the IP address belongs to a host record, this field displays the hostname. The appliance highlights disabled DHCP objects in gray. A DHCP object can be a DHCP range, fixed address, reservation, host configured for DHCP, or roaming host with an allocated IP address.
- **Type**: The object type, such as DHCP lease, host, A record, and bulk host.
- **Comment**: Information about the object. You can also select the following for display:
  - **DNS view**: The DNS view to which the object belongs. You can do the following in this tab:
  - **Add a resource record.** You can select the following from the drop-down list:
    - Host Record—for information, see Adding Host Records.
    - Range—for information, see Adding IPv4 Address Ranges.
    - Fixed Address—for information, see Adding IPv4 Fixed Addresses.
    - Reservation—for information, see Adding IPv4 Reservations.
    - A Record—for information, see Adding A Records.
    - PTR Record—for information, see Adding PTR Records.
- **Edit the properties of the selected object.** Depending on the type of object, Grid Manager displays the corresponding editor for the object. For example, if the selected object is a fixed address, Grid Manager displays the fixed address editor. When you select a lease object, Grid Manager displays the lease viewer.
- You can also modify some of the data in the table. Double click a row of data, and either edit the data in the field or select an item from a drop-down list. Note that some fields are read-only. For more information about this feature, see Modifying Data in Tables. Delete a selected object or multiple objects.
- When you select a lease object and click the Show Details icon, you can view the lease start and end dates.
- Depending on the object type, you can convert a selected object to one of the following:
  - **Reservation**
  - **Host**
  - **Fixed Address**

- **View detailed lease information about the IP address, as described in Viewing Detailed Lease Information.**
- **Print and export the information in the Related Objects table.**

**Audit History**

By default, the Audit History tab displays the following information about the last five actions performed on the selected IP:

- **Timestamp**: The day, date, and time of the operation.
- **Action**: The type of operation that was performed by the administrator.
- **Object Type**: The object type of the entry.
- **Object Name**: The name of the object.
Managing IPv4 Addresses

You can do the following from the IP Map and List panels:

- Add IP addresses to existing hosts. For information, see Adding IP Addresses to Existing Host Records.
- Clear unmanaged IP addresses. For information, see Clearing Unmanaged Data.
- Convert objects to other object types. For information, see Converting Objects Associated with IP Addresses.
- Reclaim IP addresses. For information, see Reclaiming Objects Associated with IPv4 and IPv6 Addresses.
- Ping IP addresses. For information, see Pinging IP Addresses.
- Configure and run a network discovery. For information, see IP Discovery and vDiscovery.
- Resolve discovery conflicts. For information, see Resolving Conflicting Addresses.
- Clear discovered data. For information, see Clearing Discovered Data.

Adding IP Addresses to Existing Host Records

You can add unused and unmanaged addresses, including all their information, to existing host records. When you add an unmanaged address to a host record, the appliance adds the discovered data to the host record. You can select the desired host to which you want to add the unmanaged address.

To add an unmanaged IP address to an existing host record:

1. From the IP Map or List panel, select an IP address, and then click Add -> Add to Existing Host from the Toolbar.
2. In the Select Host dialog box, do the following:
   - In the table, select the host to which you want to add the selected IP address. You can also use the filters or the Go To field to narrow down the host list. For information, see Using Filters and Using the Go To Function.
   - Click the Select icon. Grid Manager displays the Host Record editor.
3. In the Host Record editor, update the host properties as described in Choose one of the following from the Save & ... drop-down button menu.
4. Save the configuration and click Restart if it appears at the top of the screen. To close the editor without saving the changes, click the Close icon.

Clearing Unmanaged Data

You can clear the status of unmanaged data at the network and IP address levels. When you clear an unmanaged address, the status of the IP address changes to Unused. An unmanaged address is an IP address with a discovered host, is not previously known to the appliance, and does not have an A record, PTR record, fixed address, host address, lease, or is not within a DHCP range. You can change an unmanaged address to a host, a DHCP fixed address, an A record, or a PTR record. You can also clear the unmanaged data associated with the address.

To clear unmanaged data:

1. From the IP Map or List panel, select the IP address for which you want to clear unmanaged data, and then click Clear -> Clear Unmanaged Data from the Toolbar. You can select multiple IP addresses.
2. In the Clear Unmanaged data dialog box, click Yes.

Viewing Router Redundancy Information for Virtual IPs (VIPs)

1. From the Data Management tab, click CSV Job Manager from the Toolbar.
2. In CSV Job Manager, click the CSV Import tab and select the import job that you want to delete. Click the Action icon and select Delete or click the Delete pending job icon.